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Cap-dependent translation initiation
monitored in living cells

Valentina Gandin 1,3 , Brian P. English 1,3, Melanie Freeman1,
Louis-Philippe Leroux 2, Stephan Preibisch 1, Deepika Walpita1,
Maritza Jaramillo2 & Robert H. Singer 1

mRNA translation is tightly regulated to preserve cellular homeostasis. Despite
extensive biochemical, genetic, and structural studies, a detailed under-
standing of mRNA translation regulation is lacking. Imaging methodologies
able to resolve the binding dynamics of translation factors at single-cell and
single-mRNA resolution were necessary to fully elucidate regulation of this
paramount process. Here live-cell spectroscopy and single-particle tracking
were combined to interrogate the binding dynamics of endogenous initiation
factors to the 5’cap. The diffusion of initiation factors (IFs) changed markedly
upon their association with mRNA. Quantifying their diffusion characteristics
revealed the sequence of IFs assembly and disassembly in cell lines and the
clustering of translation in neurons. This approach revealed translation reg-
ulation at high spatial and temporal resolution that can be applied to the
formation of any endogenous complex that results in a measurable shift in
diffusion.

Despite three decades of extensive biochemical and genetic studies,
our understanding of translation regulation remains incomplete. The
ability to detect the dynamic behavior of individual translation factors
in live cells at a sufficient spatiotemporal resolution to understandhow
mRNA translation is dynamically regulated is essential to determine
the cell’s response to extracellular and intracellular signals to preserve
homeostasis.

Initiation of cap-dependent translation is a rate-limiting step in
translation. The best characterized regulatory step is the assembly of
eIF4F complexes on the 5’cap structure of the mRNA1. The eIF4F
complex is composed of the 5’cap-binding protein eIF4Es, eIF4Gs,
and the helicase eIF4As. It is not known whether in the living cells the
eIF4F complexes bind “enmasse” to the 5’cap or whether eIF4E binds
the mRNA first to recruit the other initiation factors. It is well
established, that the eIF4F assembly is regulated by the mechanistic
target of rapamycin complex 1 (mTORC1)2,3. mTORC1 phosphorylates
a family of inhibitory proteins called 4E-BPs2. When phosphorylated,
4E-BPs do not bind eIF4E. Since 4E-BPs and eIF4Gs share the same
binding site on eIF4Es, at initiation eIF4G binds and stabilizes eIF4E

on the 5’cap3. Unlike phosphorylation, themechanismunderlying the
de-phosphorylation of 4E-BPs remains largely unknown. Protein
phosphatase PPM1G dephosphorylate 4E-BP1 during conditions that
impaired mTOR activity. It is not known whether the cycle of
phosphorylation–dephosphorylation of 4E-BPs occurs at each re-
initiation event. Our platform applied the techniques of fluorescence
correlation and cross-correlation spectroscopy (FCS, FCCS) and
single-particle tracking (SPT) to interrogate the binding of initiation
factors to the 5’cap, with single-cell and single-molecule resolution.
To achieve this, we fused tags suitable for live imaging to endogen-
ous translation initiation factors eIF4E, eIF4G, and 4E-BP1 homo-
zygously without affecting their function.

FCS provides ensemble-averaged diffusion characteristics of
thousands of molecules (from pM to nM) in a few seconds, localized
to a diffraction-limited volume within the cell4. Moreover, dual-
fluorescence cross-correlation spectroscopy (FCCS) can measure the
diffusion of two molecules labeled with different fluorophores.
Because diffusion characteristics are recorded simultaneously, tem-
poral cross-correlation can reveal the degree of binding between two
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molecules5. SPT gives a detailed overview of molecular diffusion with
single-molecule resolution (from fM to pM). Here we combine these
two orthogonal approaches to challenge the robustness of our find-
ings. These powerful methodologies are capable of resolving early
molecular events of translation initiation on the mRNA in living cells.

By labeling individual endogenous molecules of the initiation
factors eIF4E and eIF4G, we were able to detect changes in their dif-
fusion by FCS and SPT when they bind to the mRNA as well as when
they are assembled on the 5’cap. Using the same methodology, we
investigated the diffusional behavior of the translation repressor 4E-
BP1 and its effect on eIF4E, monitoring in real-time the dissociation of
the eIF4F complexes from the mRNA to inhibit translation. We were
able to elucidate translation regulation in the cytoplasm of dividing
cells aswell as in neuronal processes, with singlemRNA resolution. Our
platform can be used to accurately elucidate the underpinnings of
mRNA translation in the native environment.

Results
Dynamic detection of eIF4E bound to the 5’cap of mRNAs
FCS reveals the timescale of fluctuations as fluorescent molecules
diffuse through the focal volume in crowded conditions. Therefore, we
reasoned that FCS had the potential to resolve differential diffusion of
initiation factors, mRNA-bound vs. -unbound, despite their high con-
centration in living cells. The focal volume is in the order of femtoliters
with detection limits ranging from 100pM to 100nM. Since the dif-
fusion of thousands of molecules is averaged in tens of seconds,
autocorrelations determine the diffusion of molecules with excellent
statistical confidence in a short time, presumably without locally per-
turbing mRNA translation.

TheHalo-tagwas fused to the non-conservedN-terminal region of
eIF4E that is dispensable for eIF4G binding6. Fusion of the Halo-tag to
eIF4E did not result in any degradation products that could lead to
artefactual changes in eIF4E diffusion in live imaging (Supplementary
Fig. 1a). Since eIF4E is anessential gene7, cells stopproliferatingwhen it
is suppressed. Halo-eIF4E was made insensitive to eIF4E shRNA by
synonymous changes in the coding sequence and was expressed in
NIH3T3 fibroblasts in which the endogenous counterpart was silenced
by shRNA (Supplementary Fig. 1b). Exogenous Halo-eIF4E was able to
bind the 5’cap and rescue cell proliferation in NIH3T3 cells (Supple-
mentary Fig 1c, d). These data demonstrated that the Halo tag did not
perturb the eIF4E function. We then determined whether FCS could
resolve JF-646Halo-eIF4E binding to the 5’cap in living NIH3T3. Pro-
longed slow fluctuations in the fluorescent signal, corresponding to
slow-moving molecules throughout the focal volume, were observed
in the cytoplasm, but not in the nucleus where translation did not
occur (Supplementary Fig 2a, c). Autocorrelations confirmed that two
eIF4E components existed in the cytoplasm of translating cells. The
fast component had a diffusion time of ~1ms (D = 17μm2/s), which is
expected for free molecules, whereas the slow component had a dif-
fusion time of ~300ms (D =0.06μm2/s).

The diffusion parameters confirmed that the mRNA-bound
molecules diffused on average more than two orders of magni-
tude slower than the unbound counterpart. Most important, this
magnitude in diffusion was expected when free molecules bound
to a slow-moving mRNA8. Only one fast-component was detected
in the cytoplasm or nucleus (Fig. 1a right, Supplementary Fig. 2b,
d) after a two-hour treatment with the mTOR inhibitor torin-1,
which promotes dephosphorylation of 4E-BP1 whereupon it
binds to eIF4E and inhibits eIF4E binding to the 5’ cap, thus pre-
venting initiation. This inhibition was confirmed by a decrease
in the expression of Cyclin D1, a canonical eIF4E-sensitive
mRNA9 (Fig. 1b).

In order to verify that the slower component of eIF4E diffusion in
the autocorrelation was due to its binding to the 5’cap of the
mRNA, the eIF4EW56A mutant was monitored in living cells. Changing

tryptophan 56 to alanine perturbs the electrostatic interactions to the
7-methyl-guanine of the 5’cap preventing eIF4E from binding to the
mRNA10,11. The shRNA-resistant Halo-eIF4E and either the SNAPf-eIF4E
or the SNAPf-eIF4E

W56A were co-expressed in NIH3T3 in which their
endogenous counterpart had been silenced by shRNA. As expected,
the wild-type version of SNAP-tagged eIF4E bound the 5’cap, while the
Trp56Ala mutation abolished the binding to the 5’cap (Fig. 1c). Auto-
correlations of cytoplasmic and nuclear SNAPf-eIF4E

W56A revealed only
one-fast component in translating cells (Fig. 1d), consistent with the
conclusion that the slow diffusion of eIF4E in translating cells was due
to its binding to the mRNA.

The eIF4F complex formation is inhibited in the cytoplasm by 4E-
BP’s binding to eIF4E uponmTOR inhibition2. We sought to determine
whether the dissociation of eIF4E from the 5’cap was triggered by 4E-
BP1 binding. SNAPf tag was fused to the N-terminus of 4E-BP1, in order
to preserve the TOR signaling (TOS) motif at the C-terminus. 4E-BP1/
eIF4E stoichiometry determines the sensitivity to active-site mTOR
inhibitors, which are more efficient with higher 4E-BPs levels12. To
assess whether the SNAPf tag perturbed 4E-BP1 function, an shRNA-
resistant SNAPf-4E-BP1 was expressed in NIH3T3 in which the endo-
genous counterpart was depleted by shRNA (Supplementary. Fig. 2a).
4E-BP1 overexpression attenuated cell proliferation compared to the
vector control, with or without the endogenous knockdown (Supple-
mentary Fig. 3b). NIH3T3 cells that expressed vector control or
SNAPf−4E-BP1 were treated with vehicle control or torin-1 for 16 h
(Supplementary Fig. 3c). The cytostatic effect of torin-1 was more
pronounced in NIH3T3 that expressed SNAPf-4E-BP1, due to its
enhancement of cap-binding and consequent competition with eIF4E.
Thesedata demonstrated that the SNAPf tagdidnot perturb the4E-BP1
function. In vitro cap-binding assays confirmed that overexpression of
SNAPf−4E-BP1 was sufficient to increase its binding to eIF4E, with a
more pronounced interaction uponmTOR inhibition (Fig. 1e). In living
cells, FCS revealed that SNAPf−4E-BP1 overexpression correlated with

JF646Halo-eIF4E dissociation from the 5’cap, that was further increased
upon mTOR inhibition (Fig. 1f).

To avoid experimental variation in eIF4E:4E-BP1 stoichio-
metry that affect translation regulation, Halo and SNAPf tags were
inserted into the endogenous Eif4e and Eif4epb1 loci, respectively,
using Crispr/Cas9 in mouse Embryonic Stem Cells (mESC)
(Fig. 2a). Since cap-dependent translation is more pronounced
throughout mESC differentiation13, parental and double knock-in
(DKI) Halo-eIF4E+/+/SNAPf-4E-BP1

+/+ mESC were differentiated into
fibroblasts (not shown). mTOR inhibition promoted eIF4E binding
to 4E-BP1 in both parental and DKI with no major differences. We
then examined the diffusional behavior of JF646SNAPf-4E-BP1 and

JF585Halo-eIF4E by fluorescence cross-correlation spectroscopy
(FCCS). We simultaneously recorded the diffusion of both fluor-
escent tags through the focal volume for thousands of molecules.
FCCS detected the simultaneous diffusion of the two fluorescent
tags (Fig. 2b). The photon counts as a function of time for the two
fluorescent channels were correlated with each other, the ampli-
tude of which reflected their simultaneous occupancy in the same
complex5,14. The cross-correlation analysis demonstrated almost
no correlation in translating cells, indicating that the tagged
molecules were not interacting (Fig. 2b, vehicle). After 30min of
mTOR inhibition, partial 4E-BP1 dephosphorylation was observed
(Fig. 2c) with JF646SNAPf-4E-BP1 and JF585Halo-eIF4E molecules
interacting together with the mRNA as demonstrated by the slow
component in the cross-correlations (Fig. 2b). After 1 h, mTOR
inhibition led to a more pronounced 4E-BP1 dephosphorylation
(Fig. 2c) with the JF585Halo-eIF4E: JF646SNAPf-4E-BP1 slow compo-
nent of the complexes (representing co-binding to the mRNA)
almost eliminated (Fig. 2b). These data indicate that 4E-BP1
initially bound eIF4E at the 5’cap to compete with eIF4G and this
event triggered subsequent eIF4E dissociation from the mRNA.
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Autocorrelations for single JF646SNAPf-4E-BP1 and JF585Halo-eIF4E
signals demonstrated that JF646SNAPf-4E-BP1 diffusion sig-
nificantly slowed down in the cytoplasm after 30-min with simul-
taneous changes in the diffusion of JF585Halo-eIF4E molecules
compared to control cells (Fig. 2d, e). At 30min, a slow eIF4E
component is still detected within the cells indicative of eIF4E:4E-

BP1 complexes binding the mRNA. As expected, mTOR inhibition
did not perturb JF646SNAPf-4E-BP1 and JF585Halo-eIF4E diffusion in
the nucleus, indicating that the binding events occurred on the
mRNA to inhibit translation initiation. After 1 h, FCS revealed that
both JF646SNAPf-4E-BP1 and JF585Halo-eIF4E diffused as fast as the
mRNA unbound nuclear counterpart (Fig. 2f), most likely due to
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Fig. 1 | Binding of exogenous Halo-eIF4E to the 5’cap is detected by FCS.
a NIH3T3 cells that express Halo-eIF4E, in which the endogenous counterpart was
silenced by shRNA, were treated for 2 h with vehicle (DMSO) or 250nM torin-1.
Averaged autocorrelation curves show temporal diffusion of Halo-eIF4E molecules
(ms =milliseconds) in the cytoplasm (black) and in the nucleus (red) in the indicated
conditions (N = 10 ± SEM). Halo-eIF4E diffusion is slower in translating cells as
compared to cells treated with torin-1. Cytoplasmic autocorrelation best fit with two
components (fast – dark yellow dotted curve: τfast = 1.14 ±0.03ms, and slow – dash-
dotted curve: τslow = 372.69 ± 10.8ms). Percentages of slow (Dslow =0.05μm2/s) and
fast (Dfast = 14.78μm2/s) moving molecules are indicated. While one-component fits
nuclear Halo-eIF4E well (see red curves), a one-component fit (see the blue dashed
curve, with dotted fit residual) cannot adequately describe the cytoplasmic Halo-
eIF4E autocorrelation curve. b Total cell lysates from the cells described in (a) were
analyzed by western blotting with the indicated antibodies. 4E-BPs phosphorylation

andCyclinD1 expressionwere significantly reduced after 2 h torin-1. c,d SNAPf-eIF4E
and SNAPf-eIF4E W56A (SNAPf-W56A) were expressed in the cells described above.
Total cell lysates were subjected to a cap-pull-down assay. Levels of Halo-eIF4E,
SNAPf-eIF4E, and SNAPf-eIF4EW56Awere detected bywestern blotting in input (5%)
and cap-bound fractions (c) using eIF4E antibody (eIF4E). Averaged autocorrelation
curves show temporal diffusion of SNAPf-eIF4E W56A in the cytoplasm (red) and in
the nucleus (black) (N = 10 ± SEM). Only one fast component was detected in both
cellular compartments (d). e, fNIH3T3 cells that express bothHalo-eIF4E and SNAPf-
4E-BP1 were treated with vehicle (DMSO) or 250nM torin-1 for 2 h. Total cell lysates
were subjected to cap-pull down assay and analyzed by western blotting in the
indicated fractions Overexpression of SNAPf-4E-BP1 is sufficient to increase its
binding to eIF4E on the 5’cap (e). Averaged autocorrelation curves show temporal
diffusion of Halo-eIF4E in the indicated conditions (N = 10 ± SEM). SNAPf-4E-BP1
expression is sufficient to displace most of the Halo-eIF4E bound to the 5’cap (f).
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the release of the tagged eIF4E:4E-BP1 complexes from the mRNA.
Within 2–3 h of torin-1 treatment, residual JF585Halo-eIF4E binding
to the mRNA was not detected, as demonstrated by the cyto-
plasmic autocorrelations overlapping with the nuclear auto-
correlations (Supplementary Fig. 4a). At this time, JF585Halo-eIF4E
molecules had translocated to the nucleus in a complex with

JF646SNAPf-4E-BP1 as demonstrated by FCCS and fluorescent
microscopy. An enrichment in JF646SNAPf-4E-BP1 molecules was
observed in the cytoplasm, most likely to prevent the binding of
eIF4E molecules to the 5’cap since tagged eIF4E:4E-BP1 complexes
are still detected by FCCS (Supplementary Fig. 4b, c).

The release of eIF4E from the 5’cap, in living cells, to inhibit
translation seems contradictory to the in vitro cap-pull down assay in
which eIF4E constitutively binds to the cap-analogs15–19.

Dynamics of eIF4E:eIF4G binding to the mRNA
FCS and FCCS were able to detect real-time binding and unbinding of

JF585Halo-eIF4E to the 5’cap mediated by the inhibitory molecule

JF646SNAPf-4E-BP1. If these events occurred on the mRNA, FCS should
be capable of detecting changes in the eIF4F complex upon acute

mTOR inhibition. Halo and SNAPf tags had been inserted into the Eif4e
and Eif4g loci, respectively, at the N-terminus as described above. The
SNAPf tag was fused to the N-terminus of eIF4G to preserve the
C-terminus which contains the MAPK-interacting kinases 1 (Mnk-1)-
binding site20. Mnk1 is recruited on the eIF4F complex by eIF4G to
phosphorylate eIF4E at Serine 209. Since eIF4E phosphorylation sti-
mulated the translation of specificmRNAs21, perturbing this regulatory
step was avoided. Tagging of endogenous eIF4E and eIF4G did not
perturb their binding to the 5’cap as compared to the endogenous
counterparts lacking the Halo and SNAPf tags respectively (Fig. 3a).
The simultaneous diffusion of JF646SNAPf-eIF4G and JF585Halo-eIF4E by
FCCS in the cytoplasmand in the nucleus was assessed. FCCS detected
stable tagged eIF4E:eIF4G interactions in the cytoplasm, where mRNA
translation occurs, but not in the nucleus (Fig. 3b, left panel). Impor-
tantly, their interactions were perturbed in the cytoplasm upon
mTOR inhibition (Fig. 3b, right panel). Autocorrelation analysis
revealed further insights into their sequential binding dynamics. In
control cells, both JF585Halo-eIF4E and JF646SNAPf-eIF4G cytoplasmic
autocorrelations show that they diffuse as two-components, fast
(~11ms,D = 1.53μm2/s) and slow (~923ms,mRNAbound,D =0.02μm2/
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Fig. 2 | eIF4E is released from the 5’cap upon binding to 4E-BP1. aDifferentiated
parental and mESC in which Halo and SNAPf tags were inserted into the EIF4E and
4EBP1 locus, respectively (Halo-4E+/+/SNAP-BP1+/+), were treated with vehicle
(DMSO) or 250 nM torin-1 for 1 h and 30min. Total cell lysates (Input) were sub-
jected to cap-pull-down assay and analyzed by western blotting using the indicated
antibodies. TheHalo andSNAPf tagsdonot affect eIF4E:4E-BP1 bindinguponmTOR
inhibition. b mESC double knock-in described in (a) were treated with vehicle
(DMSO) or 250 nM torin-1. Simultaneous diffusion of JF585Halo-eIF4E and

JF646SNAPf-4E-BP1 was analyzed by dual color cross-correlation spectroscopy in the
indicated conditions. Cross-correlation was detected, in the cytoplasm, 30 to 1 h
20min upon mTOR inhibition and with differential diffusion speed. The vehicle
showed no correlation over time (gray) (N = 10± SEM). c mESC double knock-in

described in (a) was treatedwith vehicle (DMSO) or 250nM torin-1 for 30or 90min.
Total cell lysates were analyzed by western blotting using the indicated antibodies.
4E-BP1 and rpS6were used as loading controls.d–f Individual diffusionof JF585Halo-
eIF4E and JF646SNAPf-4E-BP1 was analyzed by FCS in control cells (vehicle) (d) or in
torin-1 treated cells (e, f). Averaged autocorrelation curves show two Halo-eIF4E
components (fast and slow) and one-fast SNAPf-4E-BP1 component in the cyto-
plasm of translating cells. The nuclear diffusion of SNAPf-4E-BP1 is depicted in blue
(d). Upon 30–43min torin-1 treatment, SNAPf-4E-BP1 diffusion slows down in the
cytoplasm with Halo-eIF4E still moving slower than its nuclear counterpart (e).
After 54–90min torin-1 treatment, both Halo-eIF4E and SNAPf-4E-BP1 auto-
correlations show overall fast diffusion (f) (N = 10 ± SEM).
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s), with the majority of the eIF4Gmolecules moving on average slower
than eIF4E (Fig. 3c, d left panel). In the nucleus, only one-fast com-
ponent (diffusing at ~3ms, D = 5.59μm2/s) and so free diffusing
molecules were detected for both molecules (Fig. 3c, d right panel).
Upon 2 h of mTOR inhibition, JF585Halo-eIF4E was released from the
mRNA (Fig. 3c, left panel), as previously observed in the double knock-
in Halo-eIF4E/SNAPf-4E-BP1. This coincided with a drop in the

polysome levels accompaniedbymonosome accumulation, consistent
with defects in translation initiation (Supplementary Fig. 5a). Unlike
eIF4E, major changes in the diffusion of cytoplasmic JF646SNAPf-eIF4G
were observed only after five hours of mTOR inhibition (Fig. 3d, left
panel). After prolonged mTOR inhibition, cytoplasmic JF646SNAPf-
eIF4G autocorrelations mirrored the nuclear fast component (Fig. 3d),
suggesting that eIF4G resided longer than eIF4E on the mRNA. Since
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Fig. 3 | eIF4E and eIF4G binding to the mRNA is detected by FCS upon mTOR
inhibition. a Parental mESC and double knock-in Halo-eIF4E+/+/SNAP-eIF4G+/+

total cell lysates (input) were subjected to cap-pull-down assay (m7GTP-pull-
down) and analyzed by western blotting. eIF4G and eIF4E antibodies showed
binding of wild-type and tagged proteins to the 5’cap. Tagging of endogenous
eIF4E and eIF4G did not affect cap-binding as compared to the parental
counterpart. b–e Halo-eF4E+/+/SNAP-eIF4G+/+ cells were treated with vehicle
(DMSO) or 250 nM torin-1 for 2 h and 5 h respectively. b Simultaneous diffu-
sion of JF585Halo-eIF4E and JF646SNAPf-eIF4G was analyzed by dual color cross-
correlation spectroscopy (FCCS) in the indicated conditions. Cross-
correlation was detected in the cytoplasm of control cells (left panel), but not
in the nucleus (right panel). Minor residual eIF4E:eIF4G was detected in the

cytoplasm upon 2 h mTOR inhibition (left panel). c, d Averaged autocorrela-
tion curves representing individual diffusion of JF585Halo-eIF4E (c) and

JF646SNAPf-eIF4G (d) in the indicated conditions (N = 10 ± SEM). In control
cells, both JF585Halo-eIF4E (c) and JF646SNAPf-eIF4G (d) autocorrelations
showed slower diffusion as compared to their nuclear counterparts. No
changes were detected in the nuclear counterparts. Cytoplasmic eIF4E
molecules diffuse as fast as the nuclear counterpart as early as 2 h upon torin-1
treatment, whereas cytoplasmic eIF4Gmirrors the nuclear diffusion only after
5 h. e Total lysates (input) of cells described in (c–e) were subjected to cap-
pull-down assay (m7GTP pull-down) and analyzed by western blotting with the
indicated antibodies. eIF4E:eIF4G dissociation occurred as early as 2 h upon
torin-1 treatment.
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eIF4E enables eIF4G interactions near the 5’cap to initiate translation
this result was unexpected. eIF4G can also interact with the mRNA via
twoRNAbinding domains in the protein, via the helicase eIF4A and the
poly(A)-binding protein (PABP). The long association of eIF4G on
mRNA could be due to these multiple means to bind mRNA. Fusion of
the SNAPf and Halo tags to eIF4G and eIF4E, respectively, could impair
eIF4F complex formation. In vitro cap-pull-down assays demonstrated
that tagged eIF4E:eIF4G interactions remain mTOR-dependent
(Fig. 3e), suggesting that the unexpected kinetics observed in living
cells are not caused by the presence of the genetically encoded tags.
To further rule out the possibility that tagging of two initiation factors
altered their temporal interactions in live cells, FCS was performed in
Halo-eIF4E or SNAPf-eIF4G knock-in differentiated mESCs (Supple-
mentaryFig. 6a–c). The samebindingdynamicswereobserved in these
cells, upon mTOR inhibition eIF4G also bound longer to the mRNAs
compared to eIF4E (Supplementary Fig. 6d, e). The apparent con-
centration of initiation factors was determined in order to rule out
artefacts due to the high concentration of initiation factors. The
apparent concentrationwasestimated tobe 249nMfor JF585Halo-eIF4E
and 113 nM for JF646SNAPf-eIF4G, therefore values are well suited for
FCS22,23 (Supplementary Fig. 7). In order to investigate whether these
unexpected binding dynamics were unique to differentiated mESCs,
SNAPf-eIF4G and Halo-eIF4E were expressed in NIH3T3 cells (Fig. 4a).
Dual color FCCS was able to detect stable eIF4E:eIF4G interactions in
the cytoplasm, but not in the nucleus (Fig.4b, left panel). Acute mTOR
inhibition abolishedmost of the eIF4E:eIF4G interactions as previously
observed in differentiated mESCs (Fig. 4b, right panel). Individual
autocorrelations confirmed that JF585Halo-eIF4E, unlike JF646SNAPf-
eIF4G, was rapidly released from the mRNA (Fig. 4c, d) to retard
translation initiation as observed by polysome profiling (Supplemen-
tary Fig. 5b).

In order to validate these findings with an orthogonal approach,
single particle tracking (SPT) was used to investigate the differential
diffusion of initiation factors. SPT revealed that JF646SNAPf-eIF4G
molecules diffused on average more slowly than JF585Halo-eIF4E
(Fig. 4e, f and Supplementary Movie 1) as determined using FCS. The
tagged eIF4G apparent diffusion coefficient ranged between 0.1 and
0.8μm2/s. Interestingly, the diffusion coefficient for the free and
mRNA-bound large ribosomal subunits is 0.1 and 0.4μm2/s,
respectively24. The slower diffusion of eIF4G compared to eIF4E could
be due to association with the small ribosomal subunit through eIF325

when the ribosomewas notbound to themRNA. Individual trajectories
for JF585Halo-eIF4E and JF646SNAPf-eIF4G revealed that the eIF4G
apparent diffusion coefficient further decreased when co-moving with
eIF4E, most likely due to their stable interactions with the mRNA to
initiate translation (Fig. 4g histogram and violin plot). Altogether,
these data revealed that FCS and SPT could detect the binding of
initiation factors to the mRNA to initiate cap-dependent translation in
living cells.

Real-time detection of cap-dependent translation “hot-spots” in
primary neurons
Local mRNA translation has been postulated to play a critical role in
neuronal function, including neurite remodeling, synapse formation
and pruning, and synaptic plasticity26. Upon their transcription,
mRNAs were transported into the neuronal processes in a transla-
tionally repressed state. During transport, most of the mRNA binding
proteins (RBPs) prevent the assembly of the eIF4F complex by block-
ing eIF4E binding to the 5’cap27–29. As demonstrated above, differential
diffusion of initiation factorswas a read-out for localized events of cap-
dependent translation initiation.

In order to detect cap-dependent translation in neuronal pro-
cesses, Halo-eIF4E was expressed in primary neurons at a similar
concentration as the endogenous counterpart (Supplementary Fig. 8)
and its diffusion was analyzed upon global neuronal activation by

tetrodotoxin (TTX) withdrawal. This method utilized prolonged
treatment of cultured neurons with TTX, a sodium channel blocker,
followed by its washout to trigger neuronal activity. TTX withdrawal
stimulatedmTORactivitywithin thefirst twohours (Fig. 5a).Under this
activation protocol, a significant portion of JF646Halo-eIF4E molecules
diffused slower in the dendrites (Fig. 5c; Supplementary Movie 3), in
contrast to inactivated neuronswhere themajority of the tagged eIF4E
molecules diffused freely in the dendrites (Fig. 5b; Supplementary
Movie 2) or upon acute mTOR inhibition (Fig. 5d; Supplementary
Movie 4). JF646Halo-eIF4Emovements in activated neurons best fit with
two components: a fast apparent diffusion coefficient of 4.10μm2/s,
and a slower one of 0.32μm2/s. Translating mRNAs had an apparent
diffusion coefficient of ~0.1μm2/s24. This suggested that the slow-
moving eIF4E may reflect early events of translation initiation. Indeed,
the two-component fit of JF646Halo-eIF4E trajectories upon mTOR
inhibition revealed a reduction in the slower diffusion component
(from 76% to 48%) (Fig. 5e).

Local mRNA translation at activated synapses is thought to be
associated with long-lasting synaptic plasticity26. In mature dendrites,
we detected clusters of single exogenous JF646Halo-eIF4E molecules
lingering near the spines and diffusing slowly at or <0.1μm2/s (Fig. 5f;
Supplementary Movie 5), suggesting that translation initiation occur-
red in these areas. In order to avoid artifacts due to overexpression of
initiation factors, early events of endogenous eIF4F complex assembly
were interrogated. The double-knock in Halo-eIF4E and SNAPf-eIF4G
mESC were differentiated into neurons30 (Supplementary Fig. 9a). As
with primary neurons (Fig. 5a), TTXwithdrawal activatedmTOR kinase
and eIF4E (Supplementary Fig. 9b). In activated neurons, JF549Halo-
eIF4E and JF646SNAPf-eIF4G had differential diffusion properties as
previously detected by FCS and SPT in fibroblasts (Fig. 6a; Supple-
mentaryMovie 6). eIF4E and eIF4Gdiffusionswere the bestfit with two
components, with the faster and slower components having apparent
diffusion coefficients of >1 and 0.1μm2/s, respectively (Fig. 6b). Since
the data was recorded at a 50Hz, the frame rate is not fast enough to
record truemicroscopic diffusion coefficients, andwe report apparent
coefficients (see Fig. 6b). These data were consistent with eIF4F com-
plex formation to initiate translation in dendrites.

Using SPT, the slower diffusing Halo-eIF4E molecules were tested
as to whether they bound mRNA. ARC is an immediate early gene
rapidly transcribed upon neuronal activation to consolidate long-term
memory formation31. eIF4E activity was shown to be rate-limiting for
ARC translation32 and mTOR inhibition attenuated Arc protein
expression without affecting mRNA stability (Fig. 5a and Supplemen-
tary Fig. 9c). In order to label the endogenous ARCmRNA, a transgenic
mouse was generated that constitutively expressed GFP fused to the
coat protein PCP (PCP-GFP). The PCP-GFP tagged the endogenous ARC
mRNA in which a tandem array of PP7 binding sites (PBS) had been
inserted into the 3’UTR of the ARC gene (Arg 3.1)33. Exogenous Halo-
eIF4E was expressed in primary neuronal cultures isolated from the
mice. ARC mRNA had been previously shown to be transported along
the dendrites, with the anterograde and retrograde transport often
interrupted by pauses33. However, it remained unclear whether the
stationary mRNA was actively translated. In a dendrite, a dense area
was observed enriched with JF646Halo-eIF4E molecules (Fig. 6c; Sup-
plementary Movie 7). Importantly, two stationary ARC mRNA mole-
cules were detected inside this dense area (Fig. 6c; Supplementary
Movie 7). The binding of JF646Halo-eIF4E molecules to the ARCmRNAs
was imaged with single-molecule precision and both fast and slow-
moving eIF4E molecules were tracked (Fig. 6d; Supplementary
Movie 8). ARC mRNA trajectories were spatially and temporally cor-
related with JF646Halo-eIF4E trajectories to identify a co-moving
population for diffusion analysis. Specific co-moving events are
dominant which results in a large enrichment in short distances
between ARCmRNAs and tagged eIF4E (Fig. 6e, almost all trajectories
are under a red curve). The trajectories were used to generate a
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diffusion map and demonstrated that mRNA:Halo-eIF4E molecules
were almost immobile. This demonstrated that the static translation
factors likely represented translation initiation in neuronal processes.

Discussion
Resolving the regulation of fundamental cellular processes with sub-
cellular and single-molecule resolution in living cells is necessary to

elucidate how cellular homeostasis is preserved. mRNA translation is a
tightly regulated process, where dysregulation leads to several
pathological conditions34. How this regulation occurs is not com-
pletely understood, therefore inhibiting the development of effective
therapies. Regulation of translation presents a challenge for any live-
cell imaging methodology due to its broad range in concentration
(from a single mRNA to hundreds of thousands of ribosomes and
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perhaps millions of translation factors per cell), as well as the broad
temporal dynamic range (frommilliseconds of binding and unbinding
of translation factors, to minutes-long translation times). For this
reason, several live-cell imaging methodologies have been developed
in order to visualize hot spots ofmRNA translation35–38, but they rely on
a specifically fluorescent mRNA and/or simultaneous labeling of nas-
cent polypeptides from a specific mRNA. We have previously applied
dual-color FFS brightness analysis to detect thebinding of a translation
inhibitory protein to mRNA during steady-state, but this lacked tem-
poral and spatial resolution39. Todate,methodologies able to elucidate
the dynamic assembly of individual translation complexes on their
target mRNAs in response to cues are lacking. In this work, live-cell
spectroscopy was able to resolve the diffusion and binding properties
of thousands of molecules in tens of seconds and, when combined
with an orthogonal approach using SPT, was able to reveal sites of
global translation. The approach was then applied to interrogate the
interactions between the initiation factor eIF4E and a physiologically
important mRNA in neurons.

Furthermore, our approach revealed details on the binding stoi-
chiometry of initiation factors to the mRNA. Live imaging demon-
strated that half of the endogenously labeled cap-binding proteins
eIF4E and eIF4G were bound to mRNA, with the remaining molecules
freely diffusing. Previous work demonstrated that a reduction in eIF4E
levels by 50%didnot affectmousedevelopment7. Our data support the
hypothesis that a surplus of eIF4E exists. We speculate that the cells
benefit from an excess of eIF4Eby ensuring homogeneous distribution
throughout the cytoplasm to rapidly activate bursts of translation, for
instance, increased mitochondria activity16,40 or cell proliferation19,41.
Live imaging revealed additional insights into the regulatory dynamics
of translation. In living cells, eIF4E binding to 4E-BP1 triggered the
release of eIF4E from the 5’cap within 30min upon mTOR inhibition,
while eIF4G resided longer on the mRNA to reinitiate translation. The
release of eIF4E from themRNA in living cells was unexpected since in
a cap-pull-down assay eIF4E constitutively binds the cap analog, even
when bound to 4E-BPs. This may be due to the difference between the
two methodologies. The cap-binding assay relies on a cap-analog that
has a very high affinity for eIF4E and lacks any regulatory sequences
that may be present on target mRNAs in living cells. In the native
environment, molecular behavior is analyzed (i) on the target mRNAs,
thereby preserving any potential regulatory sequences and (ii) in
presence ofmolecules that could facilitate eIF4E dissociation from the
5’cap, for example, LARP142.

eIF4E is localized in the cytoplasm and in the nucleus, with
the nuclear eIF4E immunostaining either enriched in discrete
nuclear bodies43 or diffuse44. Several non-canonical nuclear
functions have been attributed to eIF4E45 to ultimately regulate
the export of its target mRNAs into the cytoplasm46. In the cell
types we have analyzed (NIH3T3 fibroblasts, primary neurons, and

mESC-derived fibroblasts and neurons) eIF4E spherical bodies
were not detected and, in agreement with that, temporal auto-
correlations obtained by FCS demonstrated that the majority of
the eIF4E molecules inside the nucleus diffuse as one fast-
component and are not bound to its target mRNAs. In agreement,
prolonged mTOR inhibition (>3 h), led to the accumulation of
endogenous eIF4E:4E-BP1 complexes in the nucleus most likely to
prevent eIF4E:eIF4G interactions and stable binding of eIF4E to
the 5’cap. Our data demonstrated that elucidating molecular
interactions in the native environment, while minimally perturb-
ing protein function and stoichiometry, was vital to characterize
the regulation of fundamental cellular processes.

Single-molecule detection of mRNAs revealed differential dis-
tributions in subcellular compartments in neurons, fibroblasts, and
epithelial cells emphasizing that locally regulated translation synthe-
sizes proteins where needed47. Regulation of mRNA translation is
heterogenous, mRNAs are differentially translated based on their
structure, post-transcriptional modifications, and mRNA sequence48.
The diversity of translation factors and ribosomes may fine-tune the
translation of individual mRNAs in subcellular compartments49. This
can be resolved by detecting the binding of translation complexes on
specific mRNAs in living cells.

By generating a diffusion map of endogenous initiation fac-
tors, we were able to detect slow diffusion of eIF4E (Dapp < 0.1 μm2/
s) consistent with its binding to themRNA in dendrites of activated
primary and mESC-derived neurons and in the proximity of the
spines. This apparent diffusion coefficient of bound eIF4E is con-
sistent with the microscopic diffusion coefficient we obtained
from FCS (see Fig. 1a, with a residence time of 372.7 ms for bound
eIF4E corresponding to Dmicroscopic = 0.05 μm2/s). The mechanism
behind this slow diffusion of eIF4E was confirmed by its similarly
slower diffusion properties in co-movement with ARC mRNA.
Binding events of endogenous eIF4E:eIF4G were also detected in
the dendrites of activated neurons. Notably, in neurons as in
fibroblasts, we observed an overall differential diffusion with free
eIF4G molecules diffusing more slowly than unbound eIF4E
(Dapp = 1.29 and 1.82 μm2/s, respectively, see Fig. 6b), suggesting
that it remains bound to the mRNA after initiation. Interestingly,
ARC expression is not completely inhibited at 120min upon torin-1
treatment (Fig. 5a). This is consistent with the finding that in living
cells most eIF4G molecules remain on the mRNA two hours upon
torin-1 treatment, as demonstrated by minimal changes in its dif-
fusion as compared to translating cells (Fig. 3d). All together, these
data suggests that eIF4G alone may be sufficient to promote re-
initiation. It is important to note that when recording movies of
rapid cellular diffusion, the apparent diffusion coefficients
obtained at a camera frame rate of 50 Hz do not correspond to
microscopic diffusion coefficients (as obtained from FCS in Fig. 1a,

Fig. 4 | eIF4E and eIF4G binding dynamics detected by FCS and SPT. a NIH3T3
cells that express vector control or Halo-eIF4E and SNAPf-eIF4G were treated with
DMSO (vehicle) or 250 nM torin-1 for 2 h. Total cell lysates (input)were subjected to
cap-pull-down assay (m7GTP-pull-down) and analyzed by western blotting. eIF4G
and eIF4E antibodies detected both endogenous (endog.) and exogenous (exog.)
proteins as indicated by the arrows.b Simultaneous diffusionof JF585Halo-eIF4E and

JF646SNAPf-eIF4G analyzed by dual-color fluorescent cross-correlation spectro-
scopy (FCCS) in cell treated with vehicle (left panel) or 250nM torin-1 for 2 h
(torin-1, right panel) in the cytoplasm (gray) and in the nucleus (red) (N = 10 ± SEM).
Cross-correlation was detected in the cytoplasm of translating cells, but not in the
nucleus, and abolished 2 h uponmTOR inhibition. c,d Individual JF585Halo-eIF4E (c)
and JF646SNAPf-eIF4G (d) averaged autocorrelation curves from (b). e Simultaneous
single-particle tracking of JF549Halo-eIF4E and JF646SNAPf-eIF4G was simultaneously
recorded in the cytoplasm of an NIH3T3 (dotted line outlined the nucleus). Left:
Diffusion properties of 4319 trajectories of JF549Halo-eIF4E and 4001 trajectories of

JF646SNAPf-eIF4G are displayed via heat maps. Each point is false‐colored according

to themean square displacement calculated over all displacements originating in a
circle (r = 80nm). f Co-movement analysis of JF549Halo-eIF4E and JF646SNAPf-eIF4G.
Maximum intensity projections of 5000 frames of JF549Halo-eIF4E (inmagenta) and
5000 frames of JF646SNAPf-eIF4G (in green) were simultaneously acquired at
100Hz. The co-moving JF549Halo-eIF4E (bold,magenta) and JF646SNAPf-eIF4G (bold,
green) trajectories are displayed on top. Scale bar: 10μm. Inset top: co-moving

JF549Halo-eIF4E/JF646SNAPf-eIF4G trajectories with their associated diffusion heat
maps displayed at highermagnification (scale bar: 1μm). g (left) The distribution of
apparent diffusion coefficients shifts to a slower population when JF549Halo-eIF4E is
comoving with JF646SNAPf-eIF4G (in gray). (right) Violin plots of one-step mean
square displacements for eIF4E (355,730, in magenta), for eIF4G (462,072, in
green), and for co-moving eIF4E/eIF4G pairs (7947, in gray). Box quartile method:
Tukey. The median line is shown, whisker method: min and max data. Two-sided t-
test with two mean values of two distributions (*** means p < 0.001, **
means p < 0.01).
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where free eIF4E has a residence time of 1.14 ms, which corre-
sponds to Dmicroscopic = 14.78 μm2/s).

The role of cap-dependent translation in neuronal physiology
was demonstrated using genetics and pharmacological
approaches50, but the role of spatially localized translation in neu-
ronal processes has remained unclear since these approaches lacked
sufficient spatial and temporal resolution. Our methodology identi-
fied early events of cap-dependent translation with the single-mRNA
resolution, revealing that neuronal translation occurs in clusters,

recently reported in living Drosophila embryos as well51. Transla-
tional hot spots are reminiscent of transcriptional “hot spots”52 and
may indicate a commonmechanism to enhance the concentration of
factors in local regions of the cell, perhaps through interactions of
disordered domains.

Aberrant mRNA translation results in a broad spectrum of
diseases, including cancer53, metabolic and neurodegenerative
disorders34, as well as viral infection54. Targeting the translation
machinery in diseases is challenged by our limited understanding
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Fig. 5 | Single-particle tracking ofHalo-eIF4E in primary hippocampal neurons.
Rat hippocampal neurons were activated with TTX withdrawal with or without
250 nM torin-1. a Total cell lysates were analyzed by western blotting with the
antibodies indicated next to the corresponding blot (n = 2).bDiffusion heatmap of
Halo-eIF4E trajectories obtained in inactivatedneurons (16 h TTX) at a frame rate of
100Hz (with a dotted neuronal outline, scale bar: 5μm. Each point in the image is
false‐colored according to the mean square displacement calculated over all dis-
placements originating in a circle (r = 80nm). Inset: Trajectories and corresponding
diffusion heat map (scale bar: 1μm). c Diffusion map of Halo-eIF4E of activated
neurons after TTX withdrawal (scale bar: 5μm). Inset: Trajectories and corre-
sponding diffusion heat map (scale bar: 1μm). d Diffusion speed of Halo-eIF4E in
neurons treated with 250 nM torin-1 (red colors) (scale bar: 5μm). e Single particle
tracking was recorded at a frame rate of 200Hz. The cumulative distribution
function (CDF) of all single-molecule displacements for Halo-eIF4E is shifted to the

left when compared to neurons treatedwith torin-1, which indicates a shift towards
slower diffusion for Halo-eIF4E undergoing cap-dependent translation. CDF was
obtained from 1226 and 742 trajectories in 10 individual dendrites of neurons
treated with vehicle control or torin-1, respectively. The global two-component fit
returns a global apparent Dslow of 0.32 ± 0.006 µm2/s and a global apparent Dfast of
4.10 ± 0.076 µm2/s. While the majority of control Halo-eIF4E exhibit slow diffusion
(76 ±0.6%), this percentage drops to 48± 0.6% when treated with torin-1. The data
was recorded at 200Hz, and we report apparent diffusion coefficients for that
frame rate. f Left: Medium-intensity projection of 10,000 frames of JF549Halo-eIF4E
recorded simultaneously with sparsely photo-activated PA-JF646Halo-eIF4E mole-
cules (individual PA-JF646Halo-eIF4E trajectories are shown in green) at 56Hz frame
rate (scale bar: 10μm). Right: The associated PA-JF646Halo-eIF4E diffusion heat map
depicts that slow Halo-eIF4E molecules (in blue) linger near what appear to be
spines in activated neurons (scale bar: 10μm). Spines are indicatedwith an asterisk.
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of this paramount process. This approach will have important
implications in understanding how translation dysregulation
leads to pathological conditions and identifying new therapeutic
targets. Importantly, the approach we described here can eluci-
date fundamental cellular processes without perturbing the
native environment when they result in a measurable shift
in diffusion.

Methods
Cell lines, neuronal cultures, and compounds
NIH3T3, obtained from America Type Culture Collection (ATCC) was
maintained in phenol red-free Dulbecco’s modified Eagle medium
supplemented with 10% fetal bovine serum, 1% antibiotic–antimycotic
mix (ThermoFisher), and 1% GlutaMAX™ (ThermoFisher). JM8.N4
mouse ESCs from the C57BL/6N (a generous gift from Liu laboratory,
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Fig. 6 | Simultaneous single-particle tracking of endogenous Halo-eIF4E and
SNAPf-eIF4G in mESC cells that were differentiated into neurons. a Top left:
Diffusion heat map of 18,220 JF585Halo-eIF4E trajectories from eight 10,000 frames
50Hz movies obtained from a dense network consisting of more than 100 indivi-
dual dendritic branches (scale bar: 10μm). Top center: The corresponding heat
map of the simultaneously recorded 26,438 JF646SNAPf-eIF4G trajectories. Top
right: The distributions of apparent diffusion coefficients of JF585Halo-eIF4E (in
green) and JF646SNAPf-eIF4G (inmagenta). Two-sided t-test with twomean values of
two distributions (*** means p < 0.001). b Cumulative distribution functions (CDF)
were obtained from 26,438 eIF4G and 18,220 eIF4E trajectories. While the majority
of Halo-eIF4E exhibit slow diffusion (54.3 ± 1.0%), this percentage increases to
73.2 ± 1.1% for SNAPf-eIF4G. c Thick dendritic process of a cortical neuron from
ARCP/+;PCP-GFP;v-Glut2Cre mice expressing Halo-eIF4E after TTX withdrawal
(dotted outline, scale bar: 10μm). The median projection of the JF646Halo-eIF4E
channel of 5000 frames was recorded at 100Hz (in magenta). Overlay of two ARC

mRNA trajectories (in green) labeled with PCP-GFP that were simultaneously
recorded. 1.6 × 1.6μm2 insets of JF646Halo-eIF4E and two ARC mRNA trajectories
with their associated diffusion heat maps. The mean square displacement (MSD)
curve of the twoARCmRNA trajectories depicts corralling ofmRNAs and reveals an
exploration area of 0.02μm2. d Dendritic branches of cortical neurons from ARCP/P

mice expressing Halo-eIF4E after TTX withdrawal (dotted outline, scale bar: 2μm).
Left:Median projection of the PCP-GFP channel of 6000 frames recorded at 100Hz
outlines a dense region of neuronal processes. Overlaid are the trajectories of four
ARC mRNA molecules (in white). Middle: Co-moving Halo-eIF4E molecules (in
magenta) and unbound Halo-eIF4E molecules are depicted in gray. Right: The dif-
fusion heat map of co-moving mRNA/ Halo-eIF4E molecules depicts almost static
movements of the translation factor interactingwithARC-mRNA.eThedistribution
of distances of all ARC-mRNA and all eIF4E particles (in gray) consists of a peak of
short values (<4pixels) above aflatbaseline. The co-movement algorithm (magenta
line) efficiently selects the peak of colocalized trajectories.
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Janelia Research Campus) were maintained in Knockout DMEM
(GIBCO#10829-018) supplementedwith 10% fetal bovine serumES cell
qualified (ATCC® SCRR-30-2020™), 1X GlutaMAX™ Supplement 100X
(GIBCO, #35050-061), 1X MEM non-essential amino acids solution,
100X (GIBCO, #11140050), 0.1mM 2-mercaptoethanol (GIBCO,
Cat#21985-023), 1000U/mL LIF (EMD Millipore, # ESG1106), 1μM
PD03259010 (Millipore Sigma, #PZ0162), 3μM CHIR99021 (StemCell
Technologies, #72052). The medium was renewed every second day.
All cell lines were maintained at 5% CO2 at 37 °C.

Primary rodentworkwas performed in accordancewith protocols
approved by the Janelia Research Campus Institutional Animal Care
and Use Committee (IACUC) guidelines. Mice were housed in a 12 h
light/dark cycle. Newborn pups were euthanized, and cortical tissue
dissociated, in papain enzyme (Worthington Biochemicals, ~25 U/cor-
tical pair) in dissection solution (10mM HEPES pH 7.4 in Hanks’
balanced salt solution) for 30min at 37 °C. Following trituration and
filter through a 40μm strainer, single cells were seeded in Plating
media [28mM glucose (Acros #41095), 2.4mM NaHCO3 (Sigma-
Aldrich S-8875), 100 µg/mL transferrin (Calbiochem #616420), 25 µg/
mL insulin (Sigma #I-6634 or #I-1882), 2 mM L-glutamine (GIBCO
#25030-081), 100U/mL penicillin, 10 µg/mL streptomycin and 10%
fetal bovine serum (heat inactivated; HyClone)] inMEM (GIBCO 51200-
038) and NbActiv media (BrainBits, LCC) mixed in a 1:1 ratio. 16 h later,
the media was replaced with Plating media and NbActiv mixed in a
1:33 ratio.

Rat cortical cultures were seeded on poly-D-lysine hydrobromide
(PDL) (Sigma) diluted in sterile water at 0.2 µg/mL. Cultures were then
maintained by feeding cells twice a week by replacing old media 1:1
with fresh NbActiv media.

Newborn mouse neuronal cultures were plated on PDL and lami-
nin (5μg/mL)-coated plates. Mouse neurons were seeded in Plating
media [B27/Neurobasal media, 25μM Glutamax and 5% FBS to mouse
Neuron culture media (same as mouse Plating media without FBS in
the ratio of 1:1. (Gibco #17504044).

Where indicated, cells were treated with 250nM torin-1 (Tocris)
dissolved in DMSO or with an equal amount of DMSO as vehicle con-
trol. Neuronal cultures were treated with 1.5μM Tetrodotoxin TTX)
(Sigma-Aldrich, #554412). After 16 h, TTXwas removed and substituted
with conditional media with vehicle control or 250 nM torin-1 upon 3
extensive washes with Neuronal Buffer provided by the Janelia
Research Campus Media Facility.

Differentiation of mESC to neurons or fibroblasts
For neuronal differentiation, a single mESC cell suspension was
obtained and resuspended in embryoid body (EB) media [Knockout
DMEM (GIBCO, 10829-018), 10% FBS ES Cell Qualified (ATCC® SCRR-
30-2020™), 1X GlutaMAX™ (GIBCO, #35050-061), 1X MEM non-
essential amino acids solution (GIBCO, Cat#11140050) and 55μM 2-
mercaptoethanol]. 50 cells/well were plated and EBs grow in Aggre-
Well™400 dish (StemCell Technologies #07010), according to the
manufacturer’s instructions. Briefly, EBs weremaintained for 8 days in
EBmedia in 7%CO2 at 37 °C. At day4, EBmediawas supplementedwith
5μM retinoic acid (Sigma, #R2625). The medium was replaced every
48 h. On day 8, EBs were dissociated and filtered through a cell strainer
(Falcon, #352340). Single-cell suspension was resuspended in Brain-
Phys complete media and 1.13 × 105 cells/cm2 were seeded in plates
coated with 15μg/mL poly-L-ornithine (Sigma #P4957) and 0.5μg/cm2

laminin (Gibco #23017-015). Cells were incubated for 2 h in 7% CO2 at
37 °C. Media was replaced with fresh BrainPhys complete media after
2, 24, and 48 h. Brainphys Neuronal Medium (#05790) was supple-
mented with 2% NeuroCult SM1 neuronal supplement (#05711), 1% N2
Supplement-A (#07152), 20 ng/mL BDNF (#78005), 20 ng/mL GDNF
(#78058), 1mM Dibutyryl-cAMP (#73882), 200nM L-ascorbic acid
(Millipore, AX1775-3). All supplements were from Stemcell Technolo-
gies unless otherwise specified. Differentiating mESC was maintained

in 5%CO2 at 37 °C. After 48 h, neuronswere fed by replacing half of the
media every 5 days.

For fibroblast differentiation, mESC were seeded at low density
(~20%) in 10 μg/mL fibronectin-coated plates in mESC complete
media for 16 h. mESC were then cultured in absence of LIF and 2i
(PD03259010 and CHIR99021) for 48 h to induce fibroblast
differentiation.

Lentiviral shRNA, plasmids, Crispr/Cas9 knock-in constructs,
and generation of cell lines expressing tagged translation
factors
Non-targeted shRNA control (Scrambled, SHC216) and the EIF4E
shRNA (TRCN0000077477), 4EBP1 shRNA (TRCN0000335449), and
EIF4G1 shRNA (TRCN0000096812) targeting the coding sequence
(CDS) were all fromSigma. Lentiviral backbone pLV-EF1a-IRES-Neowas
a gift from Tobias Meyer (Addgene plasmid #85139). Mouse eIF4E, 4E-
BP1, and eIF4G1CDSwere synthesized (GeneScript Biotech) by fusing a
spacer AGC-GGC-GGA-GGC-GGA-TCC- GGC-GGA-GGC-GGA-AGC (Ser-
Gly-Gly- Gly-Gly-Ser- Gly-Gly- Gly-Gly-Ser) at the N-terminal. Each CDS
was then subcloned into pLV-EF1a-IRES-Neo. Halo or SNAP-tag was
then inserted upstream of the spacer. To generate an shRNA-
insensitive CDS, silent mutations were inserted inside the seed
sequence targeted by the shRNA. Viral supernatant for each of the
indicated constructs was generated by the Janelia Viral Tool facility.
Infection was carried out with 8μg/mL polybrene. 48 h later, NIH3T3
was selected with 500μg/mL G418 for 7 days, at the end of which,
protein expression was analyzed by western blotting. The endogenous
counterparts were then silenced by infecting the cells with lentiviral
particles carrying shRNA or Scrambled control respectively, as
described above. The selection was performed with 5μg/mL pur-
omycin. Protein expression was analyzed by western blotting and the
cells weremaintained in complete DMEMwith 500μg/mLG418 + 5μg/
mL puromycin. To generate NIH3T3 that expressed both Halo-eIF4E
and SNAPf-eIF4G, cells that expressed SNAPf-eIF4G were overlayed
with Halo-eIF4E viral supernatant as described above. 48 h later, cells
were stained with 100 nM JF646-Halo ligand for 30minutes, washed
three times in 1× PBS and sorted.

To generate knock-in mESC, guide RNAs were cloned into
pTij-U6-sgRNA-CBh-Cas9-PGK-puroR (provided by the Liu lab,
Janelia). Three different gRNAs were designed and experimentally
tested for each gene (Eif4e: ENSMUST00000029803.11; Eif4g1:
ENSMUST00000115460.7; Eif4epb1 ENSMUST00000033880.6).
The following were able to generate homozygote knock-in:

eIF4E #3 − 5’ GAACCGGTGAGTATTGCCTT 3’
eIF4G1 #1 − 5’ GTGCTGGGGGGACCCTAATGTGG 3’
4E-BP1 #11.1 – 5’ GCGTGCAGGAGACATGTCGG 3’
The donor sequence (Halo or SNAPf tag flanked by ~700 nucleo-

tides complementary to the targeting sequence) was cloned into
pUC19 (provided by the Liu lab, Janelia). 500μg of gRNA and 500μg of
donor plasmids were electroporated in 1 × 106 mESC using P3 Primary
Cell 96-well Nucleofector™ Kit (Lonza, PBP3-22500) according to the
manufacturer’s instruction. After 3 days, mESC were stained with
100nM JF646 Halo- or SNAP-tag ligands for 30min, and single cells
were sorted in a 96-well plate. Clones were expanded and genotyped
using the following primers, and homozygosity was further validated
by western blotting.

eIF4E_Genot_F2: 5’ GTGGACCGGGGACTGGGGAGAC 3’
4E-BP1_Genot_F1: 5’ AGTTCTGCCACCGTCATCCCTACC 3’
eIF4G_Genot_F2: 5’ GCCCCGTGGAGCCAGGTTGATA 3’

Western blotting and antibodies
Western blottingwas performed aspreviouslydescribed15. Briefly, cells
were washed 3 times in ice-cold 1X PBS and scraped in RIPA lysis buffer
[10mM Tris–HCl pH 8.0, 150mM NaCl, 1% Triton-X100, 0.5% sodium
deoxycholate, 0.1% sodium deoxicholate, 1mM EDTA, 5mM NaF,
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10mM β-Glycerophosphate, 1mM Vanadate (New England BioLabs)
and cOmplete™, Mini, EDTA-free Protease Inhibitor Cocktail (Milli-
pore)]. Total protein lysates were separated into 12% or 4–15% Mini-
PROTEAN® TGX™ Precast Protein Gels (BioRad), transferred on a
nitrocellulose membrane (BioRad), and transferred using a semi-dry
apparatus (BioRad). The following antibodies were diluted in [1X Tris
Buffered Saline solution (TBS) pH 7.4 (ThermoFisher), 5% bovine
serum albumin (Sigma-Aldrich) and 0.1% Tween-20]: anti-eIF4E
(monoclonal, BD Transduction Laboratories™ #610269), anti-4E-BP1
(#9644), anti-eIF4G1 (#2498), anti-phosho-4E-BP1 Thr37/46 (#2855),
anti-phospho-4E-BP1 Ser65 (#9451), anti-phosho-rpS6 Ser 240/244
(#2215), anti-rpS6 (Santa Cruz Biotechnology, #sc-74459) all from Cell
Signaling Technology, anti-GAPDH (#G8795) and anti-b actin (#A5441)
from Sigma-Aldrich, anti-ARC (Santa Cruz Biotechnology, #sc-17839,
anti-HaloTag (Promega, #G9211), anti-SNAP-tag (New England Biolabs,
#P9310S) and anti-Cyclin D1 (BD Bioscience, #556470). Primary anti-
bodies listed above were used at 1:1,000. Secondary antibodies, rabbit
(Sigma-Aldrich) and mouse (Amersham) IgG HRP linked, were used at
1:5,000. Signals were revealed by Clarity Western ECL Substrate
(BioRad) and detected using a ChemiDoc™ MP Imaging System
(BioRad, #12003154).

Imaging system
Stroboscopic single particle tracking was performed using a custom-
built three-camera microscope as described in ref. 55. Briefly, the
microscope is equipped with an Olympus ×100 NA 1.5 TIRF objective.
The design around the easily accessible RAMM frame (ASI) allowed
three separate tube lenses (LAO-300.0,MellesGriot) to beplaced close
to the objective and into the infinity spaceof themicroscope, resulting
in ×166.66 overall magnification. The three Andor iXon Ultra EMCCD
cameras were operated simultaneously usingMicro-Manager (1.4.20)56

(cooled to −80 °C, 17MHz EM amplifiers, preamp setting 3, Gain 400).
The cameras were start-synchronized using a National Instruments
DAQ board (NI-DAQ-USB-6363). Lasers (490 nm, 561 nm, 639 nm, all
Vortran Stradus lasers) stroboscopically illuminated the sample using
peak power densities of∼1.7 kW/cm2 using HiLo illumination. All lasers
allow for direct TTL modulation, and stroboscopic excitations are
synchronized to the frame times of the respective cameras via Lab-
VIEW 2012 (National Instruments). During imaging, cells were main-
tained at 37 °C and 5% CO2 using a Tokai-hit stage top incubator and
objective heater.

Cellular labeling using Halo-tag or SNAP-tag ligands
Immediately prior to imaging, cells were labeled for single-molecule
imaging as described in57. The labeling conditions for co-tracking in
fibroblasts were 20 nM JF549-SNAP-tag ligand58 (30min) and JF646-
Halo tag ligand (0.5 nM, 15min)59. For Halo-eIF4E tracking in neurons,
we used 100 nM JF646-Halo tag ligand (15min), and for co-tracking in
neurons we labeled with 100 nM JF646-SNAP and JF549-Halo tag
ligands (15min). For Halo-eIF4E imaging in spines (see Fig. 5f), we also
added PA-JF646-Halo tag ligand (15min, 100 nM)60. PA-JF646 was
photoconverted by 100-μs-long excitation pulses of 407 nm laser light
(Vortran Stradus, 50W/cm2) every second. During image acquisition,
the pulse length was increased to 200-μs-long pulses.

3-camera in silico registration
Slide-mounted TetraSpeck fluorescent microspheres (T14792, Invitro-
gen) were imaged before and after data acquisition. Short movies (100
frames) of the fluorescent broadband beads in all three channels were
registered in Fiji/ImageJ2 (v.2.3.0/153q) using the descriptor-based ser-
ies registration (2d/3d + t) Fiji plugin61. Formore than two-channel bead
registration, the frames have to be set as channels (in Fiji: Image >
Hyperstacks >Re-order Hyperstack). Sub-pixel accurate registration
was achieved via Gaussianmask localization fitting of spots, which were
used to compute affine (2D) transformation models62. Since unbiased

noise distribution is essential for accurate single particle identification
and tracking, the Fiji plugin now allows for nearest-neighbor inter-
polation that does not change actual pixel intensities and thereby pre-
serves the original noise distribution (as compared to linear or other
higher-order interpolation schemes). This update is available via the Fiji
Updater (http://fiji.sc/Downloads). It can be found under Plugins >
Registration >Descriptor based Registration (2d/3d) and Plugins >
Registration >Descriptor based Series Registration (2d/3d + t).

Single particle tracking and analysis
Trajectories were obtained using DiaTrack (v. 3.04, Semasopht), which
identifies and fits the intensity spots of fluorescent particles with 2D
Gaussian functions matched to the experimentally determined point-
spread function. The diffusion maps were created using tracking
routines written in IGOR Pro 8.04 (WaveMetrics) as described in ref.
24. Briefly, local apparent diffusion coefficients of eIF4E and eIF4G are
calculated andmobility is evaluated on a 20nm× 20nm x–y grid from
the mean square displacements over a timescale of 10 or 20ms. Each
point in the image is false‐colored according to the mean square dis-
placement calculated over all displacements originating in a cir-
cle (r = 80nm).

Co-movement analysis (eIF4E and eIF4G, ARC mRNA and eIF4E)
was performed in MatLab R2014a (MathWorks) using Analyze2color
(Analyze2color_diatrack3: https://github.com/timotheelionnet/
Analyze2color)24. We localized particles and built trajectories in both
channels separately. Trajectories that dwelled within 320nm of one
another for at least 10ms were assigned as colocalized. To assess the
colocalization statistics,wegeneratedamatrixof thedistances between
all detected particles in both channels and computed the correspond-
ing histogram37. We then normalized the distance histogram to account
for the fact the area coveredby eachdistancebin grows, andplotted the
resulting normalized distribution, equivalent to the average density of
channel 1 spots observed as a function of distance from channel 2
detections. If trajectories do not colocalize, we would randomly detect
channel 1 spots at all positions in the cell without regard for channel 2
positions and therefore we would expect to observe a flat distribution.
In the case of colocalization, we would expect an enrichment of short
distances corresponding to comoving trajectories.

CDF curves were fit with a two-component fit (Eq. (1)) with A
(fraction of molecules with the diffusion coefficient D1), 1−A (fraction
ofmolecules with the diffusion coefficientD2),D1 (diffusion coefficient
of the first diffusive species in μm2/s), D2 (diffusion coefficient of the
second diffusive species in μm2/s), and t (frame time in s) as fitting
parameters:

f xð Þ= 1� A*e�x2=4D1t + 1� Að Þ*e�x2=4D2t
h i

ð1Þ

Fluorescence correlation spectroscopy (FCS)
FCS trajectories were obtained using a Leica TCS SP8 Falcon FLIM/FCS
microscopewith a Leica APO×86/NA= 1.20water-immersionobjective
equipped with a motorized correction collar (mottCorr, Leica). The
microscope was controlled using Leica’s LAS X (3.5.7.23225) and LAS X
FLIM/FCS (3.5.6) control software. Prior to the acquisition, cells at
~70–80% density were labeled with 100nM JF585-Halo tag ligand63 and
200nM JF646-SNAP-tag ligand58 for 10 and 45min, respectively. Cells
were incubated at 37 °C with 5% CO2 using a Tokai-hit stage top incu-
bator. Just before eachmeasurement, themottCorrwas adjusted using
xz-scans in reflectionmode to give the sharpest image of the living cell.
xz-scans were also used to set the central plane of the cell. A set of two
10 s measurements were obtained, three in the nucleus of the cell, and
three in the cytoplasm; between 10 and 20 cells were analyzed. The
FCS and FCCS curves were exported and averaged using Prism 7
(GraphPad). Curve-fitting was conducted using IGOR Pro 9 (Wave-
Metrics). FCS curves were fitted to a one-component fit (Eq. (2) with
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the triplet state fraction of molecules (T), the lifetime of the triplet
state (Tt, in ms), the structural parameter of the focal volume (κ = 5),
and the diffusion time (tau, in ms) as fitting parameters:

G τð Þ= 1� T +Te�τ=Tt
h i

1 +
τ

tau

� ��1
1 +

τ
tau*κ2

� ��1=2 ð2Þ

FCS curves were also fitted to a two-component fit (Eq. (3)) with T
(triplet state fraction of molecules), Tt (lifetime of the triplet state in
ms), A (fraction ofmolecules with the diffusion time tau1), κ (structural
parameter of the focal volume, κ = 5), tau1 (diffusion time of the first
diffusive species in ms), and tau2 (diffusion time of the second diffu-
sive species in ms) as parameters:

G τð Þ= 1� T +Te�
τ
Tt

� �
A* 1 +

τ
tau1

� ��1

1 +
τ

tau1*κ2

� ��1
2

"

+ ð1� AÞ* 1 +
τ

tau2

� ��1

1 +
τ

tau2*κ2
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# ð3Þ

Cap pull-down assay, polysome profiling and 35S-Met/Cys
labeling
Cap-pull down assay was performed as described in ref. 64. Briefly,
cells at ~70% density were washed 3 times in ice-cold 1× PBS and
scraped in Buffer A [50mM Tris–HCl pH 7.5, 50mM KCl, 1mM EDTA,
0.5% sodium deoxycholate, 1mM Vanadate, 1mM sodium fluoride,
20mM ß-Glycerophosphate]. Total proteins (500μg) were incubated
with 15μL Immobilized γ-Aminophenyl-m7GTP (Jena Bioscience, #AC-
155) at 4 °C for 3 h. Eluted material was analyzed by western blotting.

Polysome profiling was performed as described in ref. 65. 5–10
ODs of total RNA, measured at 254 nm, was loaded on 5–50% sucrose
gradients. Sucrose gradients were displaced with 60% sucrose and the
absorbance was recorded continuously at 254 nm using a Brandel BR‐
188 density gradient fractionation system. 35S-Met/Cys labeling was
performed as described in ref. 16.

Reporting summary
Further information on research design is available in the Nature
Research Reporting Summary linked to this article.

Data availability
The data that support this study are available from the corresponding
authors upon reasonable request. Source Data are provided in
this paper.

Code availability
We present a new Fiji plugin: Fiji plugin now allows for nearest-
neighbor interpolation that does not change actual pixel inten-
sities and thereby preserves the original noise distribution (as
compared to linear or other higher-order interpolation schemes).
This update is available via the Fiji Updater (http://fiji.sc/
Downloads). It can be found under Plugins > Registration >
Descriptor based Registration (2d/3d) and Plugins >
Registration > Descriptor based Series Registration (2d/3d + t).
The co-movement analysis code Analyze2color has now been
deposited on GitHub:

(Analyze2color_diatrack3) https://github.com/timotheelionnet/
Analyze2color.
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